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1 Introduction

This tutorial illustrates forecasting and simulation of a model using Win-
Solve. It makes use of a small quarterly model of the Philippines developed
by the Asian Development Bank (ADB) and described in Cagas et al. (2006).
Section 2 presents the model and uses it to produce a forecast over the period
2005:4 to 2010:4. Section 3 conducts two simulations with the model: an oil
proice shock and a hypothetical experiment in which the Philippine govern-
ment tackles the budget de�cit problem by reducing government expenditure
and/or increasing tax collection.

2 Forecasting with the Philippines model

In this tutorial we look at a small model of the Philippinnes, built by the
Asian Development Bank and described in Cagas et al. (2006). The model
was developed using the equilibrium correction methodology (ECM ) due
originally to Sargan (1964) but popularised by Hendry (1995) and (2002).
In this methodology, sensible long-run properties are imposed on the model
equations (although restrictions are data-permissible) while allowing short-
run dynamics to be freely estimated from the data. Most equations in the

�This paper was prepared for a HKIMR Workshop held at HKMA, Hong Kong, April
11-12 2006. The author is grateful to Duo Qin of ADB for providing the model on which
the tutorial is based. All errors are the sole responsibility of the author.
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model are demand-oriented, especially in the short run, but several of the
long run equilibrium relationships represent supply-side equations. Since the
�scal sector is one of the most crucial in the Philippine economy, this is
treated in detail and is well integrated with the other sectors. The model
consists of eight blocks: private consumption, investment, government, trade,
production, prices, monetary and labour sectors. There are 48 behavioural
and technical equations, 17 identities, and 81 variables. In the private con-
sumption block, real private consumption in the long run is a homogeneous
function of income and wealth and is also a¤ected by the deposit rate and
the unemployment rate. Real investment has a long run unit elasticity with
respect to gross domestic product and in the short run is also in�uenced
by changes in the real domestic lending rate and the total government debt
to GDP ratio (proxying risk). Central government debt is modelled as two
separate components: foreign debt and domestic debt. In the long run, the
change in both domestic and foreign debt is a linear function of the govern-
ment de�cit. In the short run the acceleration of domestic debt depends on
changes in the government debt and in the 91 day Treasury bill rate while the
acceleration of foreign debt depends on changes to the US lending rate, the
interest di¤erential between domestic and US lending rates and the exchange
rate. Imports in the long run are a homogeneous function of domestic de-
mand and external demand while also depending on relative prices between
domestic and foreign products. Exports are a function of world trade. Pri-
mary sector output is a function of the weather (the rainfall index) and the
sum of output of the secondary and tertiary sectors. Secondary sector output
is formulated in the long run as a homogeneous production function and in
the short run is also in�uenced by changes in private consumption, the share
of exports to GDP and relative de�ators among sectors. Tertiary sector real
output depends on real GNP and relative de�ators. The GDP de�ator is a
function of the de�ators of expenditure side components. The consumer price
index (CPI) is modelled in the long run as a homogeneous function of the
delators of the secondary and tertiary sectors and the narrow money (M1) to
GDP ratio. In the short run, changes in the CPI depend on changes in the
delators of the three sectors and the import price index. M1 follows a money
demand function with long-run unit elasticity with respect to GNP and also
depends on the overnight borrowing rate. This interest rate depends on past
in�ation rates and the US interest rate, following a Taylor rule. Other inter-
est rates depend on the overnight borrowing rate and the depreciation rate
of the domestic currency. The labour force is a linear function of population
but also is in�uenced by the share of the employed in the population. In
the short run, employment growth a¤ects labour force growth. In the long
run, total employment is a homogeneous function of real output and also
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depends on the real wage and the share of the primary sector in total GDP.
In the short run, employment growth is a¤ected by primary sector output
growth and changes in the share of primary and tertiary sectors in total GDP.
Employment in the secondary sector is modelled by a factor demand rela-
tionship in terms of secondary sector output and the wage rate. In the short
run, changes in the secondary sector de�ator and the share of the primary
sector in total employment also matter. Employment in the tertiary sector is
linear with respect to secondary and tertiary sector output and also depends
on the real wage rate.

2.1 Opening the model

Figure 1: Model description box

Figure 2: The model object

The �rst step is to open the �le that contains the de�nition of the model
equations. Click on the open a model icon or select the Open model
option from the File menu. A dialog box opens to allow you to select a model.
Select the �le phi model-Nov_2005.txt, and click OK. A dialog box will be
displayed, Figure 1, allowing you the opportunity to enter a description to
give the model. You can type anything here or choose to leave the description
blank. Click the OK button to exit. A new window will appear on the
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desktop representing the model object (Figure 2). The icon in this window
is a link to the model equations and double clicking the icon will open an
editor to view the equations.

2.2 Viewing the model equations

Double click on the phi model-Nov_2005.txt icon in the model object window.
This will open the editor you have set up to view �les with su¢ x TXT. The
�rst few lines of the �le will look something like Figure 3.

Figure 3: A section of model code from the Philippine model

These lines de�ne the equations for the variables PCONc_PHI (private
consumption in constant prices) and PCON_PHI (private consumption in
current prices). In this model, the variable name convention is generally
followed of using a country su¢ x _PHI to indicate The Philippines and a
lower-case su¢ x c to indicate a constant price (as opposed to current price)
variable. Note the use in the �rst equation of the WinSolve functions dlog,
d4log and the seasonal dummy function seas. The *M code before the start of
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Figure 4: Model information box

each equation indicates that both these equations are to have multiplicative
adjustments. This is appropriate given their log-linear form.
If any changes are made to the model equations while in the editor and the

�le then saved, WinSolve will automatically recompile the model equations
to incorporate the changes. In this case, when you have �nished looking at
the model equations, simply close the editor without saving and return to
WinSolve.
You can �nd out some of the properties of the model by clicking on the
icon or selecting the Model info option from the File menu. This opens

an information box as in Figure 4.You will see that the model has 76 equations
with 74 endogenous variables and 12 exogenous variables, with a maximum
lead on any equation of 0 and a maximum lag of 8. It uses 15276 bytes of
storage. The fact that the maximum lead is zero re�ects the fact that this
model contains no forward-looking expectations. Why does the model have
more equations than endogenous variables? This is because there are two
variables in the model (GPAY_PHI and GTAX_PHI ) for which there are
two alternative equations. In both cases, the �rst of the two equations is the
forecasting equation and this is used by default. The second equation will
be ignored for now although later it will be used in a simulation exercise to
be discussed below. Click the OK button to exit.
More information about the relationship betwen the model variables can

be found from the View Variable information dialog box on the Assump-
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Figure 5: Variable information box

tions menu. Selecting the endogenous variable PCONc_PHI in this dialog
box displays the information in Figure 5. This shows that the variable has
multiplicative adjustments and appears in the model with a maximum lag
of 7 periods. The Depends on box lists all the variables that appear on the
right-hand side of the equation for PCONc_PHI and, therefore, on which
it depends. The In�uences box lists all the other equations in which the
variable PCONc_PHI appears. A (1 ) in brackets indicates that, for exam-
ple, employment (EMP_PHI ) is only in�uenced by consumption after one
period, because consumption appears in the employment equation with a
one-period lag. By examining the information in this box, the complicated
inter-relationships between model equations can be explored.

2.3 Adding Data

Before any forecast can be made with the model, we need to add a data
set. This will de�ne the maximum forecast period for the model and provide
observations on the 12 exogenous variables, plus initial values for lagged
endogenous variables. In this case, we have a data set in Excel spreadsheet
format, phi_data_Nov2005.xls. Click on the (green) open a data �le icon

or select the Open data �le option from the Data menu. A dialog box
opens to allow a data �le to be selected. Select the �le phi_data_Nov2005.xls
and click OK. to open the �le.
The data �le contains quarterly data on all model variables up to 2004:4

plus data on some endogenous variables up to 2005:3 and projections for
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the exogenous variables up to 2010:4. The fact that there is data for 2005:3
only for some variables illustrates the ragged edge typical of a forecast data
set. Where data is not available, the model equation will be used to make
a forecast, but where data is available, we will want to use this data obser-
vation instead of the model equation. WinSolve will do this automatically
by allowing data to have precedence over the model equations. (This is the
default option for an incomplete data set).

Figure 6: Data information box

Information about the data set may be displayed by selecting the Data
info option on the Data menu or clicking on the (green) data info icon .
A box appears with information about the data set, Figure 6. A box appears
with information about the data set, Figure 6. Note that full data exists
from 1997:4 to 2004:4 and that the maximum solution (forecast) period is
from 1997:4 to 2010:4. There are 6 working variables. These are variables
for which no data has been provided but for which no data is needed.
Notice that several new icons on the toolbar are now ungreyed, which

indicates that they have become operational. This includes the (yellow)

Solve model icon that allows the model to be solved.

2.4 Forecast evaluation

The within-sample predictive performance of the model will be evaluated by
solving it over the historical period 1997:4�2004:4 in three di¤erent ways.
Firstly, the equations will be solved singly, using actual historical values on
the right-hand side of each equation. This will show how well each individual
equation performs in isolation from the rest of the model. Secondly, the
model will be solved as a system, but staticly, so that, in each period, actual
historical values are used for lagged endogenous variables. In this way, errors
do not cumulate dynamically and the forecast in each period is a one-step
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ahead system forecast. Thirdly, the model will be solved dynamically to give
true multi-step ahead forecasts.
Click on the Solve model icon or select the Solve model option from

the Solve menu. Change the solution period to 199704 to 200404 and uncheck
the data has precedence over equations box. (This last step ensures that the
model equations will be used in each period). Select the Single equation
solution option from the solution mode list box and type �single�in the run
name box to give the run a sensible name. Then click OK. This initiates
solution. The Solution status box displays information as the model solves.
When model solution is complete, the status box can be closed by clicking
on the OK button. Repeat the process twice more, this time choosing the
Static model solution and Dynamic model solution options respectively in
the solution mode list box and naming the runs �static�and �dynamic�.

Figure 7: Percentage forecast errors: Real private consumption

The results can now be viewed in the Results menu. Select the New
table/graph option in the Results menu or click on the graph icon . In
the dialog box, select the variable PCONc_PHI and the variable type %
changes from base. Select each of the runs �single�, �static�and �dynamic�
in turn and click the Add button to add this item to the list of items to
be viewed. Finally, click OK to �nish. The percentage forecast errors for
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private consumption from each of the three runs will be graphed together
(Figure 7). Note that both the single equation forecast errors and the static
(one-step ahead) forecast errors are small and approximately of mean zero.
In contrast, the dynamic forecast errors show a tendency to increase with the
forecast horizon and (for this variable) are predominately positive, indicating
an over-prediction of consumption of about 4%, 28 quarters into the �future�.
Of course it is a very severe test for any model to be expected to predict so
far ahead. Typically, the forecast horizon of interest would be much shorter
than this.
The information in (Figure 7) can also be viewed in di¤erent ways: as a

tabular display or as summary statistics. To change the view, click on the
system icon in the top left-hand corner of the window and choose either the
�View as table�or the �View summary statistics�option.
Finally, a �true�forecast can be run over the period 2005:1 to 2010:4. Click

on the Solve model icon or select the Solve model option from the Solve
menu. Change the solution period to 200501 to 201004 and make sure that
the data has precedence over equations box is now checked (so thatWinSolve
uses the data ragged edge correctly). Select the Dynamic model solution
option from the solution mode list box (this is the only option available in a
true forecast) and choose an appropriate name for the run such as �forecast�.
Then click OK.

Figure 8: Save results dialog box

Once this forecast has been generated, it is possible to save it to �le in
any of the data formats supported by WinSolve. Select the Save results in
�le option from the Results menu or click on the (red) Save Results icon

. Select the run �forecast�and change the dates to 199001 to 201004 so
that historical values are also saved. (See Figure 8). Click OK to exit. Enter
a �le name and �le typefor the saved �le when prompted.
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3 Simulation with the Philippines model

In this section, two policy simulations are conducted with the ADB model
of the Philippines. These replicate the simulations reported in Cagas et
al. although the results will not be the same because the version of the
model used here is slightly di¤erent to that reported in their paper. The �rst
simulation is an oil price shock, looking at the e¤ect of both an impulse and a
step increase of 10% in the Brent oil price above its base price of $60 dollars
per barrel. In the second simulation, two scenarios are explored, illustrating
ways in which the government could tackle the budget de�cit problem by
reducing government expenditure and/or increasing tax collection.

3.1 Creating a base run

The �rst step in doing a simulation is to create a base run. The base run is a
benchmark forecast against which the simulation runs will be compared, usu-
ally in terms of changes from base or percentage changes from base. The base
run will incorporate projections for the exogenous variables and judgemen-
tal adjustments on the endogenous variables that represent a �most likely�
scenario. The simulations can then explore di¤erent types of alternative
scenario, with which the base run is compared.
In the case of the ADB model, an obvious choice for base run is the

dynamic forecast over the period 2005:1 to 2010:4 that was constructed at
the end of the last section. Once this base run has been generated, this
forecast needs to become the data base to replace the forecast data base
that we were using in the forecast exercises of the previous section. There
are several alternative ways to do this in WinSolve. If the forecast has been
saved to �le, as at the end of the last section, then it can be read back in
as a new data �le to replace the existing data �le. (Use the Open data �le
option to replace the old �le). This is probably the best way to proceed when
many simulations are to be conducted over an extended period, since, once
the simulation base has been saved to �le, it will not need to be recreated
again and can just be read back from �le in subsequent WinSolve sessions.
A second way to replace the historical data set with a simulation data base
is to use the Reset data/adjustments option on the Data menu to replace
the data set with the solution from any previous run such as �forecast�. (Use
data as the type and select the run that you want to use). The third, and
probably the quickest way (but which is only available immediately after
having constructed the base forecast) is to use the option Set last solution as
base on the Solve menu.
Whichever method is chosen, the result should be the same. Checking
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Figure 9: Data information box for simulation base

the Data information box in Figure 9, a full data set should now exist from
1997:4 to 2010:4.

3.2 Oil price shock simulation

The �rst simulation to be conducted considers the e¤ect of a shock in the
Brent oil price, which in the ADB model is the exogenous variable P#OILS$.
In the base forecast, this is assumed to be constant at $60 a barrel from
2005:4 through to 2010:4. In the simulation we assume a 10% increase to $66
dollars a barrel. Two cases are considered: in the �rst case the increase is
assumed to be temporary and the price reverts to its base price from 2006:2,
in the second case the increase is permanent and continues to the end of the
simulation period.

Figure 10: Data edit window
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The shock is implemented by a multiplicative adjustment to the ex-
ogenous variable P#OILS$. This adjustment can be set through the Edit
data/adjustments option on the Data menu or the icon . In the dialog
box (Figure 10), select type Adjustments and variable P#OILS$. Then click
on the Project level/growth rate button. This opens the dialog box in Figure
11. Select the projection period 200504 to 200601 for an impulse shock or
200504 to 201004 for a step change. Click on the Constant button and put
the value 0:1 in the a: box. Then click OK to return to the edit dialog
and click the Update button to update the adjustments. Finally click OK to
leave the dialog box.
To run the simulations, click on the Solve model icon or select the

Solve model option from the Solve menu. Select the solution period as 199704
to 201004 and make sure that the data has precedence over equations box
is unchecked, as in Figure 12. Then select the Simulation option from the
solution mode list box and give the run a name such as �oil_impulse� or
�oil_step�. Then click OK.
Figures 13 and 14 show the simulation results for GDP annual growth

and CPI annual growth respectively (measured as delta logs) for the impulse
shock (unbroken line) and the step shock (dotted line) simulations. The
variables are graphed as changes from base and correspond closely to the
results reported by Cagas et al. Note that, even with a temporary shock, the
variables have not quite returned to base after �ve years.

3.3 Fiscal simulation

The second set of simulations to be conducted explore possible ways that the
Philippine government could tackle its budget de�cit problem by reducing
government expenditure or increasing tax collection. This is rather di¤erent
from the previous simulations in that it does not involve shocking a model
equation or exogenous variable. Instead, the forecasting model equation for
government non-interest payment expenditure GPAY_PHI is replaced by an
alternative equation. This equation incorporates an expenditure reduction
policy that comes into force whenever the debt to GDP ratio for the previous
year (TDEBTr_PHI ) goes above 75% or the government de�cit toGDP ratio
for the previous year (minusGDEFr_PHI ) goes above 4%. A second scenario
additionally replaces the government tax collection equation GTAX_PHI by
an alternative equation that allows for an additional 15% increase in tax
collection.
The problem faced by the government is illustrated in Figure 15, which

plots simulation base values of the debt to GDP ratio for the previous year

12



Figure 11: Projecting adjustments for P#OILS$

Figure 12: Solution dialog box for oil simulation
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Figure 13: Oil price simulation: annual GDP growth changes from base

Figure 14: Oil price simulation: annual CPI growth changes from base
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Figure 15: Simulation base Debt/GDP ratio for previous year with target

along with the target upper bound of 0:75. It can be seen that in all periods
in the base simulation, the ratio has been above the upper bound.

Figure 16: Alternative equation box

Two scenarios are considered. In the �rst the alternative equation for
GPAY_PHI alone is used. In the second case, both alternative equations are
used together. The alternative equations are switched in through the switch
alternate equations option on the Assumptions menu as shown in Figure 16.
Select the variable GPAY_PHI and choose the second alternative equation
from the list, labelled �Simulation equation�. (For the second case simulation,
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do the same for the variable GTAX_PHI ). Then click Done to implement
the changes and exit.

Figure 17: Fiscal simulations: debt to GDP ratio for previous year

Before running the simulations, ensure that any adjustments or other
changes from previous simulations have been removed. A quick way to do
this is to set all adjustments back to zero. This option is available within
the Reset data/adjustments option on the Data menu. Then, to run the

simulations, click on the Solve model icon as before. This time select
the Dynamic model solution option from the solution mode list box and set
the solution period to be 2005:4 to 2010:4.
The simulation results are presented in Figures 17 and 18. The unbro-

ken line is the �rst scenario simulation where government expenditure alone
responds to an excess debt ratio. The dotted line is the second scenario sim-
ulation where tax revenue is also increased. In Figure 17, the broken line
is the debt ratio in the simulation base. The patterns broadly follow those
reported by Cagas et al. although the cross-over in the e¤ect on GDP growth
in Figure 18 is not apparent in their graphs. The increase in GDP growth
in the two scenarios is explained by Cagas et al. as the result of increased
investment.
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Figure 18: Fiscal simulations: GDP annual growth changes from base
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